Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©March 2012

Trademarks

Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
Preface

R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Directive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Luxembourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland, United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slovenia.

EuP-Standby and Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC) regulations on power consumption in off mode or standby mode:

- Standby Mode  < 2W
- Off Mode  < 1W
CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has attained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies to products regulated by certain European health, safety and environmental protection legislation. The CE Mark is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE Marking. A notified body has determined that this device has properly demonstrated that the requirements of the directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product. Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
Preface

FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
   And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

⚠️ Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
Preface

**IMPORTANT SAFETY INSTRUCTIONS**

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC Output of 19V, 4.74A (90 Watts) minimum AC/DC Adapter.
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   ![Do not expose the computer to any shock or vibration.](image)
   ![Do not place it on an unstable surface.](image)
   ![Do not place anything heavy on the computer.](image)

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   ![Do not expose it to excessive heat or direct sunlight.](image)
   ![Do not leave it in a place where foreign matter or moisture may affect the system.](image)
   ![Don’t use or store the computer in a humid environment.](image)
   ![Do not place the computer on any surface that will block the Vents/Fan Intakes.](image)
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image 1" /></td>
<td><img src="image2.png" alt="Image 2" /></td>
<td><img src="image3.png" alt="Image 3" /></td>
<td><img src="image4.png" alt="Image 4" /></td>
</tr>
</tbody>
</table>

5. **Take care when using peripheral devices.**

<table>
<thead>
<tr>
<th>Use only approved brands of peripherals.</th>
<th>Unplug the power cord before attaching peripheral devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Image 5" /></td>
<td><img src="image6.png" alt="Image 6" /></td>
</tr>
</tbody>
</table>
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power cord if you are wet.  
Do not use the power cord if it is broken.  
Do not place heavy objects on the power cord.

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines and power cord).

You must also remove your battery in order to prevent accidentally turning the machine on. Before removing the battery disconnect the AC/DC adapter from the computer.
Polymer Battery Precautions

Note the following information which is specific to polymer batteries only, and where applicable, this overrides the general battery precaution information overleaf.

- Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mechanism and is not a cause for concern.
- Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient temperature environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- If you do not use the battery for an extended period, then remove the battery from the computer for storage.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Preface

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before restoring power to the system.
Also note the following when the cover is removed:
• Hazardous moving parts.
• Keep away from moving fan blades.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
Preface

On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Preface

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive. Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during transport. If any such wear and tear develops contact your service center.
# Contents

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>..................................................................................</td>
<td></td>
<td>........................................</td>
<td>........................................</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Quick Start Guide

<table>
<thead>
<tr>
<th>Overview</th>
<th>Advanced Users</th>
<th>Beginners and Not-So-Advanced Users</th>
<th>Warning Boxes</th>
<th>Not Included</th>
<th>System Startup</th>
<th>System Software</th>
<th>System Map: LCD Panel Open</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Preface

<table>
<thead>
<tr>
<th>The Power Sources</th>
<th>AC/DC Adapter</th>
<th>Battery</th>
<th>Turning On the Computer</th>
<th>Power Plans</th>
<th>Power-Saving States</th>
<th>Sleep</th>
<th>Hibernate</th>
<th>Shut down</th>
<th>Configuring the Power Buttons</th>
<th>Resuming Operation</th>
<th>Power Conservation Modes</th>
<th>Battery Information</th>
<th>Conserving Battery Power</th>
<th>Battery Life</th>
<th>New Battery</th>
<th>Recharging the Battery with the AC/DC Adapter</th>
<th>Proper handling of the Battery Pack</th>
<th>Battery FAQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-2</td>
<td>3-2</td>
<td>3-2</td>
<td>3-3</td>
<td>3-4</td>
<td>3-6</td>
<td>3-6</td>
<td>3-7</td>
<td>3-7</td>
<td>3-8</td>
<td>3-9</td>
<td>3-10</td>
<td>3-11</td>
<td>3-12</td>
<td>3-13</td>
<td>3-13</td>
<td>3-13</td>
<td>3-14</td>
<td>3-15</td>
</tr>
</tbody>
</table>

**Drivers & Utilities**

<table>
<thead>
<tr>
<th>What to Install</th>
<th>4-1</th>
</tr>
</thead>
</table>
XXI

Preface

Failing the POST .............................................................................................................. 5-3
Fatal Errors .................................................................................................................. 5-3
Non-Fatal Errors ....................................................................................................... 5-3
Setup Screens ............................................................................................................. 5-4
Main Menu ................................................................................................................ 5-5
System Time & Date (Main Menu) .............................................................................. 5-5
SATA Port # (Main Menu) ........................................................................................... 5-6
System/Extended Memory: (Main Menu) .................................................................... 5-6
MB Series / BIOS Revision / KBC/EC firmware Revision ........................................... 5-6
Advanced Menu ........................................................................................................ 5-7
Advanced Chipset Control (Advanced Menu) ............................................................ 5-7
Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control) ................. 5-8
Intel Smart Connect Technology (Advanced Menu) .................................................... 5-8
Intel Anti-Theft Technology (Advanced Menu) .......................................................... 5-8
SATA Mode Selection (Advanced Menu) ..................................................................... 5-8
Boot Logo (Advanced Menu) ..................................................................................... 5-9
Power On Boot Beep (Advanced Menu) ..................................................................... 5-9
Battery Low Alarm Beep (Advanced Menu) ............................................................... 5-9
Security Menu .......................................................................................................... 5-10
Set Supervisor Password (Security Menu) ............................................................... 5-10
Set User Password (Security Menu) ......................................................................... 5-11
Password on boot (Security Menu) ........................................................................... 5-11
Preface

Boot Menu .....................................................................................................................................................5-12
Boot Sequence (Boot Menu) .......................................................................................................................5-13
Exit Menu ....................................................................................................................................................5-14

Upgrading The Computer

Overview .......................................................................................................................................................6-1
When Not to Upgrade ................................................................................................................................6-2
Removing the Battery ................................................................................................................................6-4
Installing the Battery ................................................................................................................................6-5
Removing the Component Bay Cover .......................................................................................................6-6
Replacing the Component Bay Cover ......................................................................................................6-7
Upgrading the Hard Disk Drive ..................................................................................................................6-8
Upgrading the System Memory (RAM) ......................................................................................................6-11

Modules & Options

Overview .......................................................................................................................................................7-1
PC Camera Module ..................................................................................................................................7-2
PC Camera Driver Installation ....................................................................................................................7-3
Wireless LAN Module ..............................................................................................................................7-10
3rd Party 802.11b/g/n Driver Installation (for WLAN Module) .............................................................7-11
3rd Party 802.11b/g/n Driver Installation (for Combo Modules) .............................................................7-12
Intel® WLAN Driver Installation ..............................................................................................................7-13
Connecting to a Wireless Network in Windows 7 ...................................................................................7-16
Preface

Connecting to a Wireless Network Using Intel® PROSet Wireless ............................................................7-19
Intel® My WiFi Configuration ..................................................................................................................7-21
Windows Mobility Center .....................................................................................................................7-30
Intel® Wireless Display Application .......................................................................................................7-31
Intel® WiDi Application Installation .....................................................................................................7-32
Intel® Wireless Music Driver Installation ..............................................................................................7-32
Intel® WiDi Application Configuration ..................................................................................................7-33
Bluetooth & WLAN Combo Module ......................................................................................................7-36
3rd Party Bluetooth Combo Driver Installation Information ....................................................................7-37
Intel Bluetooth Combo Driver Installation .............................................................................................7-38
Standard Bluetooth Configuration in Windows 7 ..................................................................................7-39
THX TruStudio Pro Audio .......................................................................................................................7-43
THX TruStudio AP Installation ................................................................................................................7-43
THX TruStudio Pro Activation ..................................................................................................................7-44
THX TruStudio Pro Application ..............................................................................................................7-44
Intel Rapid Storage Technology .............................................................................................................7-48
IRST Driver Installation ..........................................................................................................................7-48
Intel® Smart Connect Technology .........................................................................................................7-49
Intel Smart Connect Technology Driver Installation .............................................................................7-49
Intel® Smart Connect Technology Configuration ...................................................................................7-50
Preface

Troubleshooting
Overview ................................................................. 8-1
Basic Hints and Tips .................................................. 8-2
Backup and General Maintenance ............................. 8-3
Viruses ..................................................................... 8-4
Upgrading and Adding New Hardware/Software .......... 8-5
Problems and Possible Solutions ............................... 8-7
Bluetooth Connection Problems ............................... 8-12

Interface (Ports & Jacks)
Overview ..................................................................... A-1
Notebook Ports and Jacks .......................................... A-2

Control Center
Overview ..................................................................... B-1

Video Driver Controls
NVIDIA Video (VGA) ................................................... C-1

Specifications
Processor ..................................................................... D-2
Processor ..................................................................... D-2
Processor ..................................................................... D-2
Preface
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• **Chapter 2**  A guide to using some of the main features of the computer e.g. the *storage devices* (*hard disk & card reader*), *Touchpad* & *Mouse* and Audio.
• **Chapter 3**  The computer’s *power* saving options.
• **Chapter 4**  The installation of the *drivers* and utilities essential to the operation or improvement of some of the computer’s subsystems.
• **Chapter 5**  An outline of the computer’s built-in software or *BIOS* (Basic Input Output System).
• **Chapter 6**  Instructions for *upgrading* your computer.
• **Chapter 7**  A quick guide to the computer’s *PC Camera, Wireless LAN, Bluetooth* and *Intel* modules (some of which may be *optional* depending on your purchase configuration).
• **Chapter 8**  A *troubleshooting* guide.
• **Appendix A**  Definitions of the *interface, ports/jacks* which allow your computer to communicate with external devices.
• **Appendix B**  Information on the *Control Center*.
• **Appendix C**  Information on the *video driver controls*.
• **Appendix D**  The computer’s *specification*.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in the Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included
Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks
See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the right of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by the lid/LCD).

![Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In](image)

**Shutdown**

Note that you should always shut your computer down by choosing the Shut Down command from the bottom right of the Start menu in Windows. This will help prevent hard disk or system problems.
System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find that this manual refers to the Windows 7 operating system.

Windows OS
In order to run Windows 7 without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM), however if you are running Windows 7 64 bit your computer requires a minimum 2GB of system memory (RAM).
Quick Start Guide

System Map: LCD Panel Open

Figure 1 - 2
LCD Panel Open

1. Built-In PC Camera (Optional)
2. Built-In Microphone
3. LCD
4. LED Indicators
5. Power Button
6. Keyboard
7. Touchpad & Buttons

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines above.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the key combinations (or WLAN Switch for wireless LAN only) to toggle power to the WLAN/Bluetooth and 3.75G modules, and check the LED indicator or on-screen icon to see if the modules are powered on or not (see Table 1 - 2, on page 1 - 9 Table 1 - 1, on page 1 - 7).
LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌋/محاولة</td>
<td>Orange</td>
<td>DC Power is Plugged In</td>
<td>🔋</td>
<td>Blue</td>
<td>Power Button</td>
</tr>
<tr>
<td>Blinking Orange</td>
<td>The Powered USB Port is On*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>The Computer is On</td>
<td>🔥</td>
<td>Blinking Green</td>
<td>The Computer is in Sleep Mode</td>
<td></td>
</tr>
<tr>
<td>Blinking Green</td>
<td>The (optional) Wireless LAN Module is Powered On</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orange</td>
<td>The Battery is Charging</td>
<td>🔋</td>
<td>Green</td>
<td>The (optional) Bluetooth Module is Powered On</td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>The Battery is Fully Charged</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blinking Orange</td>
<td>The Battery has Reached Critically Low Power Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Note: The powered USB 2.0 port (see Figure 1 - 6 on page 1 - 13) may be toggled on /off by means of the Fn + Power Button key combination. When the powered USB port is on it will supply power (for charging devices only, not for operating devices) when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices - see page 8 - 11).
Keyboard

The keyboard has a numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly. See *Table 1 - 2, on page 1 - 9* for details on the function keys.

**Other Keyboards**

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.

**Special Characters**

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the basic function key combinations; visual indicators are available when the hot key utility is installed.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + Power Button</td>
<td>Powered USB 2.0 Port Power Toggle</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/ Increase</td>
</tr>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use TouchPad to turn on)</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + NumLk</td>
<td>Number Lock Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + ScrLk</td>
<td>Scroll Lock Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
<td>Caps Lock</td>
<td>Caps Lock Toggle</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
<td>Fn + Esc</td>
<td>Control Center Toggle (see over)</td>
</tr>
</tbody>
</table>

Table 1 - 2 - Function & Hot Key Indicators
Quick Start Guide

Control Center

Press the **Fn + Esc** key combination, or **double-click the icon** in the **notification area of the taskbar** to toggle the **Control Center** on/off. The **Control Center** gives quick access to frequently used controls and enables you to quickly turn modules on/off.

![Control Center](image)

**Control Center**

Click on any button to turn any of the **modules** (e.g. **TouchPad, Camera**) on/off.

Click on the power conservation modes to switch between **Performance**, **Balanced** or **Energy Star** modes (see page 3 - 10). To remove the Power Conservation Modes screen just click in a blank area of the icon or press a key on the keyboard.

Click on the buttons (or just click and hold the mouse button) to adjust the slider for **Brightness/Volume**.

Click on **Display Switch** and click to choose a display mode from the menu (see page C - 12).
System Map: Front & Rear Views

1. LED Indicators
2. Multi-In-1 Card Reader
3. Battery

**Multi-In-1 (Push-Push) Card Reader**

The card reader allows you to use the most popular digital storage card formats:

- MMC (MultiMedia Card) / RS MMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC
- MS (Memory Stick) / MS Pro / MS Duo

**Battery Information**

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
**System Map: Left View**

1. RJ-45 LAN Jack
2. External Monitor Port
3. HDMI-Out Port
4. Headphone-Out Jack
5. Microphone-In Jack
6. Vent/Fan Intake
7. 2 * USB 3.0 Ports

**USB 3.0 Ports**

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7), does not support wake on USB and is not operational under DOS.

**Optical Device Drives**

To install applications and drivers etc. you will need to attach an external optical CD/DVD device to the USB ports.
System Map: Right View

1. Security Lock Slot
2. 1 * Powered USB 2.0 Port
3. DC-In Jack

To install applications and drivers etc. you will need to attach an external optical CD/DVD device to the USB ports.

**Powered USB 2.0 Port**

The powered USB 2.0 port can supply power (for charging devices only, not for operating devices) when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices). Toggle power to this port by using Fn + power button.
Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

CPU
The CPU is not a user serviceable part.

Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake while the computer is in use.
Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon, and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View to view the control panel icons.
Video Features

NVIDIA® Optimus™ Technology

NVIDIA® Optimus™ technology is a seamless technology designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. The computer will automatically switch between the integrated UMA (Unified Memory Architecture) GPU (iGPU) and the discrete GPU (dGPU) when required by the applications in use.

You can switch display devices, and configure display options, from the Display control panel (in Appearances and Personalization) in Windows 7 (see over). For more detailed video information see “Video Driver Controls” on page C - 1.
To access **Display (Control Panel) and Screen Resolution** in *Windows*:

1. Click **Start** and click **Control Panel**.
2. Click **Display** (icon) - In the **Appearances and Personalization** category.
3. Click **Adjust Screen Resolution/Adjust resolution**.
4. Alternatively you can right-click the desktop and select **Screen resolution**.
5. Use the dropbox to select the screen **Resolution** (Figure 1 - 9).
6. Click **Advanced settings** (Figure 1 - 9) to bring up the **Advanced** properties tabs.

*Figure 1 - 9 - Screen Resolution*
Quick Start Guide

To access the Intel(R) Graphics and Media Control Panel:
1. Click Advanced settings (Figure 1 - 9 on page 1 - 17) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button) (Figure 1 - 10) in the Intel Graphics & Media Control Panel tab.
   OR
3. Right-click the desktop and select Graphics Properties from the menu.
   OR
4. Click the icon (Figure 1 - 10) in the taskbar and select Graphics Properties from the menu.
   OR
5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View.
6. Choose the application mode (Basic, Advanced or Wizard) required.

Figure 1 - 10 - Intel Graphics and Media Control Panel
To access the *NVIDIA Control Panel*:
1. Right-click the desktop and select **NVIDIA Control Panel** (Figure 1 - 11).
   OR
2. Double-click the icon (Figure 1 - 11) in the **Windows** control panel.

*Figure 1 - 11 - NVIDIA Control Panel*
Quick Start Guide

Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 14) allows you to configure power management features for your computer. You can conserve power by means of power plans and configure the options for the power button, sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power saver plan may have an effect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create a new plan. Click Change plan settings and click Change advanced power settings to access further configuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 11.

Figure 1 - 12 - Power Options
Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Multi-In-1 Card Reader
- Touchpad and Buttons/Mouse
- Audio Features

External Optical (CD/DVD) Device Drives

To install applications and drivers etc. you will need to attach an external optical CD/DVD device to the USB ports.
Features & Components

Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For further details see “Upgrading the Hard Disk Drive” on page 6 - 8.

Figure 2 - 1
Hard Disk Location
Multi-In-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the card reader driver (see “CardReader” on page 4 - 6).

- MMC (MultiMedia Card) / RS MMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC
- MS (Memory Stick) / MS Pro / MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the cards.

Card Reader Cover

Make sure you keep the cover in the card reader when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

Push-Push Card Reader

The card reader features a push-in/push-out card insertion and ejection mechanism. Simply push the card to insert and eject it, however Ms Duo cards require an adapter.

Figure 2 - 2
Front View
1. Card Reader
Features & Components

2 - 4 Touchpad and Buttons/Mouse

The Touchpad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The Touchpad buttons function in much the same way as a two-button mouse.

Once you have installed the Touchpad driver (see “Touchpad” on page 4 - 6) you can configure the functions by double-clicking the Touchpad driver icon in the notification area. You may then configure the Touchpad tapping, buttons, scrolling (see sidebar), pointer motion and sensitivity options to your preferences.

Touchpad Scrolling

This computer model series may feature different Touchpad versions. These Touchpads may differ in their vertical scrolling function in most scrollable windows.

Some Touchpads require sliding the finger up and down on the right of the Touchpad to scroll the window. Other versions require tapping/holding down the finger at the top right or bottom right of the Touchpad to scroll the window.

Figure 2 - 3
Mouse Properties
The Synaptics Gestures Suite application allows you to use a specific gesture (action) on the surface of the Touchpad to perform specific actions to manipulate documents, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.

You can get a clearer view of the gestures involved by clicking the Show Video option for each gesture item.

Select the gesture (Pinch Zoom, Rotating, Three Fingers Down and Three Finger Flick) in the Device Settings > Settings left tree menu and click the Show Video button to see the demonstration video.

For more details on any of the gestures see the help in the lower part of the right menu window.

Figure 2 - 4
Mouse Properties - Device Settings
Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you to scroll horizontally and vertically. Place two fingers, slightly separated, on the Touchpad surface and slide both fingers in the direction required (in a straight continuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel in Windows applications that support CTRL + scroll wheel zoom functionality. Place two fingers on the Touchpad (for best results use the tips of the fingers) and slide them apart to zoom in, or closer together to zoom out.
Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments. Place a finger down on the left “target” zone and keep it stationary. Place another finger near the middle of the Touchpad and slide it in a circular motion around the stationary finger (clockwise or counterclockwise) to rotate the object.

Figure 2 - 7
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of applications such as browsing the Internet or scrolling through a photo viewer. The Three Fingers Down gesture may be used to launch user-selectable applications.

Figure 2 - 8
Flick/Press Gesture
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, from the HD VDeck icon on the desktop or VIA HD Audio Deck control panel.

The volume may also be adjusted by means of the Fn + F5/F6 key combination.
**Expert Mode** will allow you to access more advanced configuration menus for Speaker, Microphone and Stereo Mix.

Also see “**THX TruStudio Pro Audio**” on page 7-43 for more audio configuration information.

---

**Syncing Left & Right Volume Balance**

If you wish to adjust the left and right channel volume levels separately, you will need to adjust this from the VIA HD Audio Deck in Expert Mode.

Click **Speaker** in VIA HD Audio Deck (in Expert Mode) and click the **Sync Left and Right volume** button (see left). You can then adjust the volume sliders independently (this setting also controls the **Balance** setting in the Windows Sound control panel).

**Figure 2 - 10**

VIA HD Audio Deck (Expert Mode)
Features & Components
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the LCD and hard disk drive) or the whole system. This chapter covers:

- The Power Sources
- Turning On the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Power Conservation Modes
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.

(Note: All pictures used on the following pages are from the Windows 7 OS.)
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the right of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 15).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 11.
Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

You can use the OS’s Power Options control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring the Power Buttons” on page 3 - 8 for details).

Shut Down

Note that you should always shut your computer down by choosing the Shut Down command from the bottom right of the Start menu in Windows. This will help prevent hard disk or system problems.
### Power Management

#### Power Plans

The computer can be configured to conserve power by means of **power plans**. You can use (or modify) an existing **power plan**, or create a new one.

The settings may be adjusted to set the **display** to turn off after a specified time, and to send the computer into **Sleep** after a period of inactivity.

Click **Change plan settings** and then click **Change advanced power settings** to access further configuration options in **Advanced Settings**.

*Figure 3 - 1
Power Plan Advanced Settings (Win 7)*

---

**Resuming Operation**

See **Table 3 - 1, on page 3 - 9** for information on how to resume from a power-saving state.

**Password**

It is recommended that you enable a password on system resume in order to protect your data.
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** (you may need to click *Show additional plans* to view the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered. The recommended **Balanced** power plan will balance power saving and performance.
Power Management

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. *Win 7* uses the **Sleep, Hibernate** and **Shut Down** power-saving states.

**Sleep**

In **Sleep** all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter **Sleep** to save power.

The PC wakes from **Sleep within seconds** and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in **Sleep** is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from Shut down takes longer than from Sleep or Hibernate.
Configuring the Power Buttons

The power/sleep button (**Fn** + **F4** key combo) and closed lid may be set to send the computer into a power-saving state. Click **Choose what the power buttons do** on the left menu in **Power Options** to bring up the menu.

**Password Protection**

It is recommended that you enable a password on wake up in order to protect your data.

However you can disable this setting from the **Power Options** menu by clicking **Require a password on wakeup** in the left menu, and selecting the options (click **Change settings that are currently unavailable**).

*Figure 3 - 4*

**Power Options**
**Define Power Buttons**
Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button ($\text{Fn} + \text{F4}$ key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td></td>
<td>Press the Power Button Press the Sleep Button ($\text{Fn} + \text{F4}$ Key Combo)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td>Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td></td>
<td>Press a Key or Move the Mouse/Touchpad</td>
</tr>
</tbody>
</table>

### Closing the Lid
If you have chosen to send the computer to **Sleep** when the lid is closed, raising the lid will wake the system up.

### Table 3 - 1
**Resuming Operation**

**Power Button**
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).
Power Management

3 - 10 Configuring the Power Buttons

Power Conservation Modes
This system supports Energy Star power management features that place comput-ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity. Adjust Power Conservation Modes from the Control Center:

1. Press the **Fn + Esc** key combination to toggle the Control Center on/off.
2. Click either the **Performance**, **Balanced** or **Energy Star** button.
3. Click in a blank area of the icon or press a key on the keyboard to exit **Power Conservation Mode** without making any changes.

The **Energy Star** setting will result in maximum power saving, but with the possible loss of some performance.

Setting the mode to **Balance** will give power saving matched with performance.

**Performance** will give optimum computer performance but with less power conservation.

---

*Figure 3 - 5*  
Control Center
Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan **Change plan settings > Change advanced power settings** (see **Figure 3 - 1 on page 3 - 4**).

Click the battery icon in the taskbar to see the current battery level and charge status.

---

Low Battery Warning

When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

---

Figure 3 - 6
Battery Icon (Taskbar) & Battery Advanced Settings
Conserving Battery Power

- Use a **power plan** that conserves power (e.g. *Power saver*), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

*Figure 3 - 7 Windows Mobility Center*
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage) see “Removing the Battery” on page 6 - 4.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 7 for information on the battery charge status, and to “Battery Information” on page 3 - 11 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a **power plan** for discharging the battery and set all the options to **Never**.

![Power Plan Create](image)
3. Click *Change plan settings* (after creating it) and click *Change plan settings > Change advanced power settings*.
4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 1%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing
**Power Management**

**How do I fully charge the battery?**
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

**How do I maintain the battery?**
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install

The *Device Drivers & Utilities + User’s Manual* disc contains the drivers and utilities necessary for the proper operation of the computer. *Table 4 - 1, on page 4 - 3* lists what you need to install and it *is very important that the drivers are installed in the order indicated* (all drivers provided are for *Windows 7 with Service Pack 1*).

The procedures for installing drivers for the **PC Camera, Wireless LAN** and **Bluetooth & WLAN Combo** modules are provided in “*Modules & Options* on page 7 - 1.”

**Driver Installation & Power**

When installing drivers make sure your computer is powered by the AC/DC adapter connected to a working power source. Some drivers draw a significant amount of power during the installation procedure, and if the remaining battery capacity is not adequate this may cause the system to shut down and cause system problems (note that there is no safety issue involved here, and the battery will be rechargeable within 1 minute).
Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, (you should note down the drivers as you install them).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2
### Table 4 - 1 - Driver Installation

Note that for Intel and some 3rd party WLAN & Bluetooth Combo modules you need to install both the WLAN & Bluetooth drivers.

<table>
<thead>
<tr>
<th>Drivers for Windows 7 with Service Pack 1</th>
<th>Page 4 - 6</th>
<th>Page 7 - 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 6</td>
<td></td>
</tr>
<tr>
<td>Video (VGA)</td>
<td>Page 4 - 6</td>
<td>Wireless LAN Module</td>
</tr>
<tr>
<td>NVIDIA Video (VGA)</td>
<td>Page 4 - 6</td>
<td>Intel® Wireless Display Application</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 6</td>
<td>Bluetooth &amp; WLAN Combo Module</td>
</tr>
<tr>
<td>CardReader</td>
<td>Page 4 - 6</td>
<td>THX TruStudio Pro Audio</td>
</tr>
<tr>
<td>Touchpad</td>
<td>Page 4 - 6</td>
<td>Intel Rapid Storage Technology (required for hard disks in AHCI mode)</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page 4 - 7</td>
<td>Intel® Smart Connect Technology</td>
</tr>
<tr>
<td>USB 3.0</td>
<td>Page 4 - 7</td>
<td></td>
</tr>
<tr>
<td>MEI Driver</td>
<td>Page 4 - 7</td>
<td></td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 7</td>
<td></td>
</tr>
</tbody>
</table>
Drivers & Utilities

Manual Driver Installation
Click *Browse CD/DVD* (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable *Windows Update* in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft). See “*Windows Update*” on page 4 - 8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the *Control Panel* in the *Windows OS* and double-click the *Programs and Features* icon (*Programs > Uninstall a program*). Click to select the driver (if it is not listed see below) and click *Uninstall*, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the *Programs and Features* menu:

1. Click *Start*, and click *Control Panel* (or point to *Settings* and click *Control Panel*).
2. Double-click *Device Manager* (*Hardware and Sound > Device Manager*).
3. Double-click the *device* you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click *Driver* (tab) and click the *Update Driver* or *Uninstall* button and follow the on screen prompts.
User Account Control

If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or “Install” to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter (and in Chapter 7 Options & Modules), are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a re-start is required to install the driver.

Make sure any modules (e.g. PC Camera, WLAN or 3.75G/HSPA) are ON before installing the appropriate driver.
Drivers & Utilities

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3.Install nVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next > Next.
4. Click the RESTART NOW button to restart the computer.

Note: After installing the video driver go to the Display/Display Settings control panel to adjust the video settings to the highest resolution.

LAN
1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

CardReader
1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement and click Next.
4. Click Finish > Restart Now to restart the computer.
Hot Key
1. Click Install Hotkey AP > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

USB 3.0
1. Click Install USB 3.0 Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

MEI Driver
1. Click Install MEI Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish.

Audio
1. Click Install Audio Driver > Yes.
2. Click Next.
3. Click the button to agree to the license and click Next.
4. Click Next > Next > Next.
5. Click Finish to restart the computer.

Note that after installing the audio driver the system will not return to the Drivers Installer screen. To install any of the optional drivers listed overleaf, eject the Device Drivers & Utilities + User’s Manual disc and then reinsert it (or double-click the disc icon in My Computer), and click Option Drivers (button) to access the optional driver menu.

It is recommended you now also install the Intel Rapid Storage Technology driver (see “IRST Driver Installation” on page 7 - 48 - required for AHCI mode hard disks).
Windows Experience Index

After the drivers are installed follow this procedure to ensure an accurate rating from the *Windows Experience Index* (make sure the AC/DC adapter is plugged in):

1. Click **Start**, and click **Control Panel**.
2. Click **Performance Information and Tools** (System and Security > System > Check the Windows Experience Index).
3. Click **“Rate this computer/Refresh Now/Re-run the assessment”**.
4. The computer will take a few minutes to assess the system performance.
5. Close the control panel.

---

**Windows Update**

After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest **hotfixes** from Microsoft).

To enable **Windows Update** make sure you are connected to the internet:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Windows Update** (System and Security/Security).
3. Click **Check for updates** (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click **Install now** (button) to begin checking for the updates.
6. Click **Install updates** (button) to install the updates.
Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

![Drivers Installer - Option Drivers Menu](image)

*Figure 4 - 3 - Drivers Installer - Option Drivers Menu*

*Note that for Intel and some 3rd party WLAN & Bluetooth Combo modules you need to install both the WLAN & Bluetooth drivers.*
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.
The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a **POST**, including a quick test of the on-board RAM (memory).

As the **POST** proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run **Setup**.

If there are no problems, the **Setup** prompt will disappear and the system will load the operating system. Once that starts, you can’t get into **Setup** without rebooting.

The **Aptio Setup Utility** tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

To enter **Setup**, turn on the computer and press **F2** (give the system a few seconds to enter **Setup**). If the **Boot Logo** is enabled the **F2** on screen will be **highlighted** to illustrate that the system is processing the request during the **POST** (or press **F7** for boot options). If you get a “Keyboard Error”, (usually because you pressed **F2** too quickly) just press **F2** again.

If the computer is already on, reboot using the **Ctrl + Alt + Delete** combination and then hold down **F2** when prompted. The **Setup** main menu will appear.

To see the boot options press **F7** and choose your preferred boot device.
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) and you can then press F7 (the F7 on screen will be highlighted to illustrate that the system is processing the request) for boot options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be highlighted to illustrate that the system is processing the request) to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
Setup Screens

The following pages contain additional advice on portions of the Setup. Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ▸ next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
**System Time & Date (Main Menu)**

The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
BIOS Utilities

*SATA Port # (Main Menu)*
Pressing **Enter** opens the sub-menu to show the configuration of an optical Device/HDD on the computer’s SATA Ports.

*System/Extended Memory: (Main Menu)*
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

*MB Series / BIOS Revision / KBC/EC firmware Revision*
This item contains information on the BIOS version etc., and is not user configurable.
Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to adjust the **Bluetooth Power Setting**.
Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)
You can adjust the Bluetooth module power setting to your preference. The default setting (Disabled) will see the Bluetooth module powered off when the system is started up or restarted. Enabling the power setting will have the module retain the last power status (on or off) before any restart or shut down.

Intel Smart Connect Technology (Advanced Menu)
Smart Connect is a technology that makes checks on web applications that are open even when the computer is in sleep mode, and thus allows updates to be made without the need to turn the computer on.

Intel Anti-Theft Technology (Advanced Menu)
Anti-Theft Technology, which is built-in to the processor of the computer, allows system administrators to render your computer useless to thieves by sending a poison pill encrypted SMS message over a 3G network etc. Administrators can also remotely unlock a recovered computer quickly, or direct the system to send location information (GPS coordinates) back to a central server.

SATA Mode Selection (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in IDE (native/compatible), AHCI (Advanced Host Controller Interface) modes from this menu. The SATA Mode should be set BEFORE installing an operating system, and after you have backed up all necessary files and data (see sidebar).
Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup. If you disable the Boot Logo you will not see the F2 Enter Setup or F7 Boot Options prompts on the screen, however you can still press these keys, while the boot screen is displayed, to perform the Enter Setup or Boot Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
Security Menu

Set Supervisor Password (Security Menu)

You can set a password for access to the Aptio Setup Utility. This will not affect access to the computer OS (only the Aptio Setup Utility). If you set a supervisor password you can then add a user password and password on boot.
Set User Password (Security Menu)
You can set a password for user mode access to the **Aptio Setup Utility**. This will not affect access to the computer OS, (only the **Setup** utility) unless you choose to set a **Password on Boot** (see below). Many menu items in the **Aptio Setup Utility** cannot be modified in user mode. **You can only set the user password after you have set the supervisor password.**

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (**you may only set a password on boot if a supervisor password is enabled**). If “**Enabled**” is selected, only users who enter a correct password can boot the system (**see the warning in the sidebar**). The default setting is “**Disabled**”.

**Note:** To **clear existing passwords** press **Enter** and type the existing password, then press **Enter** for the new password (without typing any password entry) and **Enter** again to confirm the password clearance.

**Password Warning**
If you set a boot password (Password on boot is “**Enabled**”), **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
When you turn the computer on it will look for an operating system (e.g. *Windows 7*) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot Option Priorities**. Item specific help on the right is available to help you move devices up and down the order.
Boot Sequence (Boot Menu)
Use the arrow keys to move up and down the menu, and go to either Network Device BBS Priorities or Hard Drive BBS Priorities and use the + and - keys to move the device’s boot priority up and down the list (the selected device will be highlighted in white).
Click **Save Changes and Reset** to save all changes made. Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose **Load Setup Defaults** to restore the original **Setup** defaults and return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

• Removing the Battery & Installing the Battery
• Removing the Component Bay Cover & Replacing the Component Bay Cover
• Upgrading the Hard Disk Drive
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

---

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines and power cord).

You must also remove your battery in order to prevent accidentally turning the machine on. **Before removing the battery disconnect the AC/DC adapter from the computer.**

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning restoring power to the system.

Also note the following when the cover is removed:

- Hazardous moving parts.
- Keep away from moving fan blades.
Upgrading the Computer

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.
Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch 1 in the direction of the arrow.
3. Slide the latch 2 in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow 3.

Figure 6 - 1
Battery Removal
Installing the Battery

1. Turn the computer over.
2. Insert the battery into the compartment 1.
3. Slide the latch 2 in the direction of the arrow to lock the battery in place.

Figure 6 - 2
Battery Installation
Upgrading The Computer

Removing the Component Bay Cover

1. Turn off the computer, and turn it over and remove the battery (see page 6 - 4).
2. Slide the latch 1 in the direction of the arrow.
3. Slide the latch 2 in the direction of the arrow, and hold it in place.
4. Carefully slide the cover in the direction of the arrow 3 to align with the markers on the case 4, and then lift the cover 4 off the computer.

Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 3
Component Bay Cover Removal
Replacing the Component Bay Cover

1. Make sure latch 1 is in the unlocked (i.e. slide to the left towards the unlocked symbol) position (otherwise the cover cannot be properly reinserted).
2. Press the cover firmly down with your hand, as illustrated, to insure the cover is in place.
3. Align the markers on the case 2 and cover first, and then slide the cover in the direction of arrow 3 until it clicks into place.
Upgrading the Hard Disk Drive

The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page D - 3). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

HDD System Warning
New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the discs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
1. Turn off the computer, and turn it over and remove the battery (see page 6 - 4) and bottom cover (see page 6 - 6).
2. Remove the screw 1.
3. Slide the hard disk assembly in the direction of arrow 2 until you can see the (gold colored) HDD connector 3.

**Hard Disk Handling**

Do not press down on the center off the hard disk as this area houses the hard disk drive motor.

**Figure 6 - 5**

Hard Disk Screw Removal
Upgrading The Computer

4. When the connector can be viewed, lift the assembly up in the direction of arrow 4 to remove the HDD assembly from the bay.
5. Remove the screws 5 & 6, bracket 7 and adhesive cover 8.
6. Reverse the process to install a new disk and do not forget to replace the screws and cover.

Figure 6 - 6
Hard Disk Assembly Removal
Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page D - 3 for details of supported module types).

1. Turn off the computer, and turn it over and remove the battery (see page 6 - 4) and bottom cover (see page 6 - 6).
2. The memory (RAM) slots will be visible at point 1.

Figure 6 - 7
Memory (RAM) Location
Upgrading The Computer

3. Gently pull the two release latches on the sides of the memory socket in the direction indicated by the arrows (2 & 3) in Figure 6 - 8.

4. The RAM module will pop-up, and you can remove it.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

Single Memory Module Installation
If your computer has a single memory module, then insert the module into the Channel 0 (JDIMM1) socket. In this case this is the lower memory socket (the socket closest to the mainboard).
5. Pull the latches to release the second module if necessary.
6. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.
7. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.
8. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.
9. Replace the component bay cover (see “Replacing the Component Bay Cover” on page 6 - 7).
10. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.
Upgrading The Computer
Chapter 7: Modules & Options

Overview

This chapter contains information on the following modules, which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

- PC Camera Module
- Wireless LAN Module
- Intel® Wireless Display Application
- Bluetooth & WLAN Combo Module
- THX TruStudio Pro Audio
- Intel Rapid Storage Technology
- Intel® Smart Connect Technology

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Driver Installation & Module Power

Make sure any modules (e.g. WLAN, PC Camera & Bluetooth modules) are ON before installing the appropriate driver.
PC Camera Module

Before installing the driver, make sure the PC Camera is on. Use the **Fn + F10 key combination**, or Control Center button, to toggle power to the PC Camera module. Make sure you install the drivers in the order indicated in **Table 4 - 1, on page 4 - 3**.

There are a number of different camera modules available with this computer model series. You will have the appropriate application installed for your camera. **Make sure you access the application via the desktop shortcut.**

PC Camera Application and Power-Saving States

If the computer enters **Sleep** or **Hibernate** mode while running the camera application, the program will stop running, and will need to be restarted when the system resumes from the power-saving state.

PC Camera Driver Uninstallation

If you need to uninstall the driver, then uninstall the **WebCam Installer** item from the **Programs and Features** control panel in **Windows**.
PC Camera Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install Webcam Driver > Yes.
4. Click Finish to restart the computer.
   OR
   Click Next > Finish.
5. Run the camera application program from the desktop shortcut (if the hardware is turned off use the Fn + F10 key combination, or Control Center button, to turn it on again).

PC Camera Screen Refresh

The PC Camera module supports a frame rate of 12 fps. If you find that the screen refresh rate is subject to lag or stuttering, then reduce the window size, or adjust the Output Size and/or Color Space Compression.

To reduce Output Size and/or Color Space Compression run the camera application, click Options and select Video Capture Pin. Adjust the settings from the appropriate pull-down menu.
 Modules & Options

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Figure 7 - 1
Audio Setup for PC Camera

Right-click
Camera Application
The camera application is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 4) and select Start Capture.
3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the “Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 7 in order to save file space, and help prevent system problems.
Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page 7 - 6), limit the file size of the captured video or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
Eliminating Screen Flicker

If you find that the video screen in the camera program is flickering, you can try to adjust the setting in the **Video Capture Filter** options.

1. Run the camera application from the desktop shortcut.
2. Go to **Options** and scroll down to select **Video Capture Filter**.
3. Click either **50Hz** or **60Hz** under **PowerLine Frequency**.

---

**Figure 7 - 2**

Video Capture Filter

---

**Camera Options**

The video capture filter figure pictured here may appear slightly different for some camera modules. To adjust the anti flicker properties look under the headings **Anti Flicker/Frequency/PowerLine Frequency**.
Taking Still Pictures
The camera application allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder
The Snapshot folder's default location is on the desktop. Do not move this folder or an error may appear when you try to take a still picture.

If you accidentally delete or move the folder, you can create a new Snapshot folder on the desktop in order to capture the files.
Wireless LAN Module

If you have included an Intel® or 3rd Party Wireless LAN (or WLAN & Bluetooth combo) module in your purchase option, make sure that the WLAN module is on before installing the driver.

Use the Fn + F11 key combination, or Control Center button, to toggle power to the Wireless LAN module. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. The operating system is the default setting for Wireless LAN control in Windows 7.

Note you need to install both the WLAN & Bluetooth drivers for the Intel WLAN & Bluetooth Combo modules.
3rd Party 802.11b/g/n Driver Installation (for WLAN Module)

See over for information on installing the drivers for the 3rd party WLAN & Bluetooth combo module.

If you see the message “Found New Hardware” click Cancel to close the window.

1. **Make sure the module is powered on**, and then insert the *Device Drivers & Utilities + User’s Manual* disc into an attached DVD drive.
2. Click **Option Drivers** (button).
3. Click **2.Install WLAN Driver > Yes**.
4. Choose the language you prefer and click **Next**.
5. Click **Next**.
6. Click **Finish** to restart the computer.

**Note**: The operating system is the default setting for Wireless LAN control in *Windows* (see page 7 - 16).
3rd Party 802.11b/g/n Driver Installation (for Combo Modules)

If you see the message “Found New Hardware” click Cancel to close the window.

1. **Make sure the module is powered on**, and then insert the *Device Drivers & Utilities + User’s Manual* disc into an attached DVD drive.
2. Click **Option Drivers** (button).
3. Click **2. Install WLAN Driver > Yes**.
4. Click **Next** (if a prompt appears to ask you to turn the Bluetooth power on, press the **Fn + F12** key combination to do so, otherwise the driver will not be installed).
5. Click **Finish** to restart the computer (see sidebar for important information).

**Note**: The operating system is the default setting for Wireless LAN control in *Windows* (see page 7 - 16).
Intel® WLAN Driver Installation

For a standard Intel® WLAN driver installation and configuration choose the Typical Installation below and use the Windows OS for Wireless LAN control (see overleaf). If you want to use Intel® PROSet/Wireless WiFi Connection Utility as your WLAN interface, and/or add Intel® MyWifi Technology (Personal Area Network) see overleaf.

**Typical Installation:**
1. If you see the message “Found New Hardware” click Cancel to close the window.
2. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
3. Click Option Drivers (button).
4. Click 2.Install WLAN Driver > Yes.
5. Click Next > Next.
6. Click the button to accept the license and click Next.
7. Click Typical > Install.
8. Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows (see “Connecting to a Wireless Network in Windows 7” on page 7 - 16).
Custom Installation (for Intel® ProSet and/or Intel® MyWiFi Technology):
Note that if you wish to install Intel® MyWiFi you will need to install Microsoft.net Framework 4.0 (or later version) before installing the driver as per the procedure below. To get the Microsoft.net Framework file go to the Microsoft website, search for the file, Download it and then install it.

1. If you see the message “Found New Hardware” click Cancel to close the window.
2. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
3. Click Option Drivers (button).
4. Click 2.Install WLAN Driver > Yes.
5. Click Next > Next.
6. Click the button to accept the license and click Next > Custom.
7. To install Intel® MyWiFi Technology click the icon alongside Intel® MyWiFi Dashboard and select “Entire feature will be installed on local hard drive” (see Figure 7 - 3 on page 7 - 15).
8. To install Intel® PROSet/Wireless WiFi Connection Utility click the icon alongside it and select “Entire feature will be installed on local hard drive” (see Figure 7 - 3 on page 7 - 15).
9. Click Next > Install > Finish.
10. See “(For Intel® WLAN Modules Only)” on page 7 - 19 or “Intel® My WiFi Configuration” on page 7 - 21 for further information.
Install Intel® MyWiFi Technology & Intel® PROSet/Wireless WiFi Connection Utility

Figure 7 - 3

Wireless LAN Module 7 - 15
Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on.

1. Click the taskbar notification area wireless icon, and then double-click an access point to connect to or click to Open Network and Sharing Center if you do not see a network you want to connect to in the taskbar menu (a list of options will appear allowing setting changes, and creating a new network).
2. You may need to enter a security key for any access point to which you are trying to connect.
3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access further options for the connection.

Figure 7 - 5
Network Location Set
5. Click the taskbar icon to see any currently connected networks.

6. To disconnect from the wireless network, you can click the taskbar wireless icon, click the active connection, and then click Disconnect (button).

Security Enabled Networks

You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites, and files, etc.

Figure 7-6
Click Taskbar Icon
Menu - Disconnect

7 - 18 Wireless LAN Module
Connecting to a Wireless Network Using Intel® PROSet Wireless

(For Intel® WLAN Modules Only)
1. Make sure the Wireless LAN module is on.
2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All Programs > Intel PROSet Wireless > WiFi Connection Utility).
3. Click to select a network from the found list WiFi network access points, or click Refresh to update the list.

![Figure 7 - 7 Intel® PROSet/Wireless WiFi Connection Utility (Connect)](image-url)
4. Click **Connect** to connect to the select WiFi network access point.
5. If the access point is encrypted then you will need to enter the password and click **OK**.

6. You can turn **WiFi On/WiFi Off** from the button at the bottom of the Utility.
7. To disconnect, select the connected access point and click **Disconnect**.
8. Select **Help** from the menu at the top of the utility (or at the bottom right) to bring up the **Help** menu.
Intel® My WiFi Configuration
*(For Intel® WLAN Modules Only)*

Intel® My WiFi Technology (Intel® MWT) uses your WLAN to transform your system into a Wi-Fi Personal Area Network, and enables you wirelessly share your videos, photos, music with other WiFi enabled devices, while still connecting to the Internet through your WiFi wireless connection.

Intel® MWT also features a chat function, and offers you the option of being able to create a WiFi hotspot from your computer. Intel® MWT offers greater range and speed than other personal area networks, and does not require an access point.
Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Make sure the Wireless LAN module is on.
2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All Programs > Intel PROSet Wireless > Intel(R) My WiFi Dashboard), or click the icon in the notification area of the taskbar (or right-click and select Open Dashboard).
3. An initial welcome message will appear on the first run of the program (click “Don’t show this message again” to turn this off in future).
Intel® My WiFi Interface

Figure 7 - 10
Intel® My WiFi Utility - Interface
Intel® My WiFi Help
Click the Help icon in the dashboard to bring up the Help menu and select and item from the Contents menu to obtain the help information.

Figure 7 - 11
Intel® My WiFi Utility - Help
Preferences
Click the Options icon and select Preferences to configure the options.

Figure 7 - 12
Intel® My WiFi Utility - Preferences
Hotspot
You can turn the computer into a hotspot to allow other devices to connect to it (and any locally connected devices), and also (if available) the internet.

1. Click the Hotspot icon to turn the Hotspot on.
2. The Hotspot settings tab shows the SSID and password (you will need to enter this information when accessing the hotspot from the client computer/device).
3. Click OK to close the Hotspot settings.

Figure 7 - 13
Intel® My WiFi Utility - Hotspot
Finding Devices
You can find any Nearby Devices by clicking the Refresh button in the main window. Click again at any time to update the list. If a lot of devices are found they will be listed on multiple pages and you can use the left or right buttons to turn the pages.

Sensitivity
The Sensitivity controls displays available devices based on their signal strength and proximity e.g. decreasing (-) the sensitivity lists only devices closest to the computer’s location.

Group Devices by Type
If you click Group by type it will list all devices according to their type in a folder group. Double-click on any group folder to see the devices of that type listed. There are 12 possible device types available.

Search
If you want to search for a particular device by name then enter the device name in the Search field to return results for devices matching the name of the device.
Favorite Devices
The Favorite Devices tab is where you keep devices to which you connect most often, and this is particularly useful in environments where many devices are listed nearby. A favorite device will display the icon.

To make any device a favorite just click to select it and select Add Favorite.

Figure 7 - 14
Intel® My WiFi Utility - Interface

7 - 28 Wireless LAN Module
Connect to a Device
1. Click the device you want to connect to, and click the connect icon.
2. An invitation will be sent to the target device.
3. The user must then accept the invitation.
4. After the invitation is accepted the connection will be made.
5. Use the Windows Network and Sharing Center to set permissions for viewing and sharing the resources on your computer with another connected computer.

Further Information
For information on how to block/unblock devices, setting Do Not Disturb, sharing an internet connection and chat options see “Intel® My WiFi Help” on page 7 - 24.
Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon to access the network menu.

![Windows Mobility Center](image)

Figure 7 - 15
Windows Mobility Center
Intel® Wireless Display Application

The Intel® Wireless Display Application (requires Intel® Centrino WLAN/ Combo module), in conjunction with a compatible video adapter (purchased separately), allows you to display the contents of the notebook display on another display (e.g. HDTV) without the need to have cables stretching across a room. You can then play games, browse the internet, display videos or photo slide shows on your TV/external display without using HDMI or A/V cables.

Before configuring the Intel® WiDi application you will need to set up your compatible adapter with your display/speakers. Connect the adapter using an HDMI or A/V cable and turn on the display (or in the case of speakers connect them to the wireless speaker adapter with the cables provided with the adapter), and then set the display to the appropriate input channel (see the documentation supplied with your compatible adapter for full details).

Intel® WiDi also incorporates Intel® Wireless Music which allows you to wirelessly stream audio from your computer to speakers connected to a compatible wireless speaker adapter (purchased separately).
Modules & Options

Intel® WiDi Application Installation
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install WiDi AP > Yes.
4. Click Next.
5. Click the button to accept the license and click Next.
6. Click Finish.

Intel® Wireless Music Driver Installation
If you wish to use your system to stream wireless audio to speakers connected to a compatible wireless speaker adapter you will need to install the *Intel(R) Wireless Music Driver*.

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into an attached DVD drive.
2. Click Browse and browse to the driver location (X: denotes your DVD drive):
   - X:\Options\14_WiDi\WiDi_Music\autorun.exe
3. Click Next.
4. Click the button to accept the license and click Next.
5. Click Finish.
6. Follow the procedure overleaf to setup WiDi or Wireless Music.
Intel® WiDi Application Configuration

1. Click Start > All Programs > Intel Corporation > Intel(R) Wireless Display > Intel(R) Wireless Display, or double click the icon on the desktop.
2. Click I agree to the terms of this license (button).
3. The application will scan for any connected compatible adapters (or you can click the Scan for available adapters button to enable Intel My WiFi Technology).
4. Click to select any detected adapters, and click **Connect**.
5. The system will then prompt you to enter the **4-digit security code** which will be displayed on the external TV Screen (or press the **connect** button on the wireless speaker adapter).
6. Enter the code for the video adapter and click **Continue**.

---

**Figure 7 - 17**
Intel® WiDi Connect & Enter Security Code
7. You will then be prompted to enter a name for the video adapter and click Continue.
8. Click Finished to complete the setup.

Test Audio Adapter

To verify a successful audio connection (for Intel® Wireless Music), select the "Test your audio connection" link or select "Finished" to bypass the test.

You can select "Play Sample" to play an audio test sample from your adapter to the connected speaker set.

Figure 7 - 18
Intel® WiDi Connected
Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd Party) then install the driver as instructed from the appropriate page (see below).

Use the Fn + F12 key combination to toggle power to the Bluetooth module.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F12 key combination to toggle power to the Bluetooth module, and check the LED indicator to see if the module is powered on or not (see Table 1 - 2, on page 1 - 9, Table 1 - 1, on page 1 - 7).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

- For 3rd party Bluetooth combo modules see the information in “3rd Party Bluetooth Combo Driver Installation Information” on page 7 - 37 and “Standard Bluetooth Configuration in Windows 7” on page 7 - 39.

- For Intel Bluetooth combo modules see the installation procedure see “Intel Bluetooth Combo Driver Installation” on page 7 - 38 and “Standard Bluetooth Configuration in Windows 7” on page 7 - 39.
3rd Party Bluetooth Combo Driver Installation Information

For 3rd party WLAN & Bluetooth combo modules it is not necessary to install the Bluetooth driver separately from the WLAN driver (see “3rd Party 802.11b/g/n Driver Installation (for Combo Modules)” on page 7 - 12), which should have already been installed (a warning message will appear if you attempt to install the Bluetooth driver).

Use the “Standard Bluetooth Configuration in Windows 7” on page 7 - 39 to configure the Bluetooth settings.

High Speed Bluetooth Data Transfer

The Combination Wireless LAN & Bluetooth module supports high speed data transfer. However, to achieve such transfer speeds, both devices must support high speed data transfer.

To obtain high speed data transfer make sure that both the WLAN and Bluetooth modules are powered on.

Check your Bluetooth compatible device’s documentation to confirm it supports high speed data transfer.
Intel Bluetooth Combo Driver Installation

Note this driver is required only for the Intel combo Bluetooth and WLAN module only.

1. Before installing the driver make sure the Bluetooth module is powered on (use Fn + F12 key combination), then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive. If a Found New Hardware window appears, click Cancel in all windows that appear, and then proceed to install the driver as below.

2. Click Option Drivers (button).
3. Click 4. Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Finish.
7. See over for configuration instructions.

Note that, at the time of going to press, Intel® Centrino® Wireless-N 2230 and Advanced-N 6235 WLAN & Bluetooth combo modules use the standard Bluetooth configuration in Windows 7 (see “Standard Bluetooth Configuration in Windows 7” on page 7 - 39).
Standard Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the \text{Fn} + \text{F12} key combination to power on the Bluetooth module.
2. A Bluetooth icon \text{will appear in the taskbar.}
3. You can then do any of the following to access the \text{Bluetooth Devices} control panel.
   - \text{Double-click} the taskbar icon `\` to access the \text{Bluetooth Devices} control panel.
   - \text{Click/Right-click} the taskbar icon `\` and choose an option from the menu.

Add a Device
Click \text{Start}, and click \text{Control Panel} and then click \text{Devices and Printers} (Hardware and Sound). Click \text{Add a device} to search for any available Bluetooth devices.

Bluetooth Module & Resuming From Sleep Mode
The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (\text{Fn} + \text{F12}) to power on the Bluetooth module after the computer resumes from Sleep.

\text{Figure 7 - 19}  
\text{Bluetooth Devices & Click Icon Menu}
To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.
3. On first connection the computer will provide you with a pairing code to be entered onto the device.
4. Enter the code into your Bluetooth enabled device and follow any on-screen instructions to complete the pairing.

5. **Windows** will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to be installed.

7. Click **Close**.

![Pairing Code Example](image1.png)

**Pairing Codes**

The example outlined here shows a connection to a mobile device. Other devices e.g. computers, may have a slightly different connection procedure, and may require you to confirm a pairing code is correct on both devices. Follow the on-screen instructions to complete the pairing.

![Pairing Complete & Bluetooth Device Enabled](image2.png)
To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:
   - Change the name of the device (click Bluetooth, type a new name and click OK).
   - Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

Figure 7-23
Bluetooth Settings - Options
THX TruStudio Pro Audio

Install the THX TruStudio AP to allow you to configure the audio settings to your requirements for the best performance in games, music and movies.

THX TruStudio AP Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install THX TruStudio AP > Yes.
4. Choose the language you prefer and click Next.
5. Click Yes to accept the license.
6. Click Next.
7. Click Full Installation (button).
8. Click Next > Finish to restart the computer.

Note that THX TruStudio Pro will be disabled when you are connecting to an external display through an HDMI connection.
THX TruStudio Pro Activation
On the first run of THX TruStudio Pro you will need to **activate** the application.

1. To activate the application you will need to be connected to the internet.
2. Double-click the **THX Activate** icon on the desktop and click the **Activate** button.
3. The program will connect to the internet to verify the activation key.
4. Click **Finish** to complete the application activation.
5. Restart the computer after the process is complete.

THX TruStudio Pro Application
The application can be run from the shortcut in the **Start** menu (Start > All Programs > Creative > THX TruStudio Pro Settings).

---

**THX Audio & HDMI**
Note that the THX audio effects do not apply to audio generated through an HDMI connection.

---

Figure 7 - 24
THX TruStudio Pro Menu
THX Control Panel
Each control has an On/Off button to allow you to enable/disable the control, and most controls feature a slider to adjust the levels (the subwoofer may be turned on/off).

- **Surround**: Provides virtual sound channels to control the level of immersion.
- **Crystalizer**: Enhances audio to make it sound livelier.
- **Speaker**: Enhances the bass level of the sound system.
- **Smart Volume**: Minimizes sudden volume changes to avoid the need for constant adjustment.
- **Dialog Plus**: Enhances dialogue levels for movies etc.
THX TruStudio Pro Headphone Settings

THX TruStudio selects the built-in speakers by default and this setting may cause some sound quality issues when using headphones. To adjust the settings for headphones do the following:

1. Run the THX TruStudio Pro application.
2. Select Settings from the menu.
3. Select Headphones from the drop-down menu (you can adjust the slider for crossover frequency).
4. Click OK and close the application.
THX TruStudio Pro & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the THX Tru Studio Pro controls will be disabled.
2. A warning box will pop-up and will prompt “Do you want to select another audio device now?”.
3. Click No to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display).

Figure 7 - 28
THX TruStudio Pro HDMI Display Warning
Intel Rapid Storage Technology

Install the Intel Rapid Storage Technology to support your SATA drive if set up in AHCI mode in the BIOS (see “SATA Mode Selection (Advanced Menu)” on page 5 - 8).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 6.Install IRST Driver > Yes.
4. Click (click the button to “Install Intel® Control Center”) Next > Yes > Next > Next.
5. Click Finish to restart the computer (you will need to restart the system again after the computer has rebooted).

* The Intel® Control Center provides a central starting point for Intel applications to make it easier to find programs required. Access the Intel® Control Center from the Start > All Programs > Intel > Intel® Control Center.
Intel® Smart Connect Technology

Intel® Smart Connect Technology periodically, and briefly, wakes the computer from Sleep mode in order to update information for certain applications (e.g. to get mail from Microsoft Outlook) as required. These updates can therefore be made without having to turn the computer on, and applications will be up to date when the computer resumes from Sleep mode (make sure that Intel Smart Connect Technology is enabled in the BIOS - see “Intel Smart Connect Technology (Advanced Menu)” on page 5-8).

Note that the applications need to be on and running when the computer enters Sleep mode in order to get updates.

Intel Smart Connect Technology Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click Install ISCT Driver > Yes.
4. Click Next.
5. Click the button to accept the license agreement and click Next.
6. Click Next > Install > Finish.
7. Click Yes to restart the computer.
**Intel® Smart Connect Technology Configuration**

1. Access the Intel(R) Smart Connect Technology application from the Start menu.
2. Click Basic (tab) and adjust the slider to set the update frequency (note that the slider balances between “More Frequent Updates” and “More Battery Life”).
3. Note the sidebar warning about the use of Intel(R) Smart Connect Technology aboard aircraft and make sure your wireless LAN module is off during air travel.
4. In order to update any applications, they will need to be on and running when the computer enters Sleep mode.

---

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F11 key combination to toggle power to the WLAN module, and check the LED indicator to see if the module is powered on or not (see Table 1 - 2, on page 1 - 9 Table 1 - 1, on page 1 - 7).

---

**Figure 7 - 29**

iSCT Basic
5. Click Advanced (tab) to access the Extended Power Savings settings.

6. **Extended Power Savings** allows you to set a time period during which the computer will update less often (e.g., at night while you are asleep or whenever you are at work).

7. Updates set during this time period will be performed every two hours, and this will override the settings selected in the Basic tab in order to conserve power consumption.

*Figure 7-30: iSCT Advanced*
8. Click the Help tab and click Topics to access the main Help menu.

Intel WLAN Modules

If your purchase option includes an Intel WLAN module, (with Intel’s PROSet Wireless Connection Utility installed), Intel® Smart Connect Technology will search for WiFi networks around you that you have previously accessed.

If no known WiFi networks are found, your computer will not update again until it recognizes a known WiFi network.

Figure 7-31
iSCT Help
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

• **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Indicators (see “LED Indicators” on page 1 - 7) to see the computer’s power status.

• **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

• **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or power button to wake-up the system.

• **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness.

• **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

• **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always backup your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.

- Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a Supervisor password for the BIOS (see “The Setup Utility” on page 5 - 2).

- Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
**Viruses**

- Install an Anti-Virus program and keep the **definitions file** (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the **definitions file updates** are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. **Note**: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

- Keep a “**Bootable CD-ROM/DVD-ROM/USB storage device**” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
**Troubleshooting**

## Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the <strong>power</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery LED power indicator is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing battery power too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a <strong>Power Options</strong> scheme (see “<strong>Power Plans</strong>” on page 3 - 4) check its settings. You may also be using a USB device/external device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual battery operating time is shorter than expected.                | **The battery has not been fully discharged before being recharged.** Make sure the battery is fully discharged and recharge it completely before reusing (see “**Battery Information**” on page 3 - 11).  
**Power Options have been disabled.** Go to the **Control Panel** in **Windows** and re-enable the options.  
**A peripheral device/USB device is consuming a lot of power.** Turn off/remove the unused device to save power. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels <strong>too hot</strong>.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into <strong>Hibernate</strong> mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “<strong>Overheating</strong>” on page 1-14). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
</tbody>
</table>
| **Nothing appears** on screen. | *The system is in a power saving mode.* Toggle the sleep/resume key combination, **Fn + F4** (see “**Configuring the Power Buttons**” on page 3-8).  

*The screen controls need to be adjusted.* Toggle the screen control key combinations **Fn + F8/F9**. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls.  

*The computer is set for a different display.* Toggle the screen display key combination, **Fn + F7**. If an external monitor is connected, turn it on.  

*The screen saver is activated.* Press any key or touch the **Touchpad**. |
| No image appears on the **external monitor** I have plugged in and powered on. | *You haven’t installed the video driver and configured it appropriately from the Control Panel.* See **Appendix C** for instructions on installing and configuring the video driver. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the <strong>boot password</strong>.</td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
</tbody>
</table>

#### Password Warning

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sound cannot be heard or the <strong>volume is very low</strong>.</td>
<td>The volume might be set too low. Check the volume control in the <strong>Volume Control Panel</strong> in the Windows taskbar, or use the key combination <strong>Fn + F5</strong> and <strong>F6</strong> (see “Function/Hot Key Indicators” on page 1 - 9) to adjust.</td>
</tr>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td>If the LED 📦 is lit, then Num Lock is turned <strong>ON</strong>. (see “LED Indicators” on page 1 - 7).</td>
</tr>
</tbody>
</table>

#### Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system's power saving features have timed-out.</em> Use the AC/DC adapter, press the sleep <em>(Fn + F4)</em> key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a <strong>power saving mode</strong>.</td>
<td>Power Options features are not enabled. Go to the <em>Windows</em> Power Options menu and enable the features you prefer (see <em>“Power-Saving States” on page 3 - 6</em>). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN</strong> or <strong>Bluetooth</strong> modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the LED indicator and/or function key indicator to see if the WLAN/Bluetooth module is on or off (see <em>“LED Indicators” on page 1 - 7</em>). If the LED indicator is off, then press the Fn + F11 (WLAN)/WLAN Switch or Fn + F12 (Bluetooth) key combination(s) in order to enable the modules (see <em>Table 1 - 2, on page 1 - 9</em>).</td>
</tr>
<tr>
<td>The <strong>PC Camera</strong> module cannot be detected.</td>
<td><em>The module is off.</em> Press the Fn + F10 key combination in order to enable the module (see <em>“Function/Hot Key Indicators” on page 1 - 9</em>). Run the camera application to view the camera picture.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth/ PC Camera</strong> modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in <em>“Modules &amp; Options” on page 7 - 1</em>).</td>
</tr>
</tbody>
</table>
## Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A file cannot be copied to/from a connected Bluetooth device.</td>
<td>The transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the device to your computer until the file transfer process from the computer has been completed.</td>
</tr>
<tr>
<td>The Bluetooth module is off after resuming from Sleep.</td>
<td>The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from Sleep.</td>
</tr>
<tr>
<td>I am sliding my finger up and down on the right side of the Touchpad to scroll a Window and the Touchpad does not respond.</td>
<td>There are different Touchpad versions available on this computer, and this version requires tapping/holding to scroll. Either tap repeatedly, or hold the finger down, at the top or bottom right of the Touchpad (depending on the scrolling direction required) to scroll the window.</td>
</tr>
</tbody>
</table>
| The computer is off (or in Sleep Mode) but powered by the AC/DC adapter plugged in to a working outlet, or by battery with a capacity above 20%. I have plugged a device into the powered USB port in order to charge it, but the device is not charging. | The port is not powered on. Toggle power to the port using the Fn + power button combination.  
This function may not work with certain external USB compliant devices (check your device’s documentation). If this is the case, power the computer on and connect the external USB device in order to charge it.  
Note that this function is designed to help charge USB compliant devices, but is not designed to allow their operation. |
Troubleshooting

Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Windows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have connected, or tried to connect to, a Bluetooth device previously).

![Figure 8-1 - Device Manager](image)

Bluetooh Peripheral Devices
You will need to repeat the procedure listed here for all Bluetooth Peripheral Devices listed under Other Devices i.e. until there are no more Bluetooth Peripheral Devices listed under this menu heading.
6. Right-click **Bluetooth Peripheral Device** and click on **Update Driver Software**.
7. Click **Browse my computer for driver software**.
8. Click **Let Me pick from a list of device drivers on my computer**.

![Figure 8 - 2 - Browse my computer.../Let me pick from...](image)

9. Select **Bluetooth Radios** from the list.

![Figure 8 - 3 - Select Bluetooth Radios](image)
Troubleshooting

10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for Microsoft Corporation to appear in the list).
12. Select Windows Mobile-based device support from the Model list.

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

8 - 14 Bluetooth Connection Problems
15. The **Device Manager** should now display the **Windows Mobile-based device support** under **Bluetooth Radios**.
16. You will need to repeat the process for any other **Bluetooth Peripheral Devices** listed under **Other Devices**.

*Figure 8-5 - Device Manager - Bluetooth Radio*
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks)

Notebook Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader Port</td>
<td>The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>External Monitor (VGA) Port</td>
<td>This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or simultaneous display on the LCD and external monitor/FPD.</td>
</tr>
<tr>
<td>HDMI-Out Port</td>
<td>The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device by means of a HDMI cable. <strong>Note that HDMI carries both audio and video signals.</strong></td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. <strong>Note:</strong> Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
</tbody>
</table>
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions. <strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device). <strong>The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.</strong> USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0. Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7) and does not support wake on USB. <strong>Note:</strong> The powered USB 2.0 port (see “System Map: Right View” on page 1 - 13) may be toggled on/off by means of the <strong>Fn + Power Button</strong> key combination. When the powered USB port is on it will supply power when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices - see page 8 - 11). <strong>Note:</strong> This function is designed to help charge USB compliant devices, but is not designed to allow their operation.</td>
</tr>
</tbody>
</table>

---

**Note:** Broadband (e.g. ADSL) modems usually connect to the LAN port. **Security Lock Slot** To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store. **USB 2.0/1.1 Ports** These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device). **The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.** USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0. Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7) and does not support wake on USB. **Note:** The powered USB 2.0 port (see “System Map: Right View” on page 1 - 13) may be toggled on/off by means of the **Fn + Power Button** key combination. When the powered USB port is on it will supply power when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices - see page 8 - 11). **Note:** This function is designed to help charge USB compliant devices, but is not designed to allow their operation.
Interface (Ports & Jacks)
Appendix B: Control Center

Overview

The following chapter will give a quick description of the functions of the Control Center. The Control Center gives quick access to frequently used controls, power management features and enables you to quickly turn modules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down and move the slider where applicable. Certain functions will automatically be adjusted when a power mode is selected.

Figure B - 1 - Control Center
Power Modes
You can set a **Power Mode** by clicking the appropriate icon at the top of the **Control Center**. Each power mode will affect the power status of modules (e.g. WLAN, Bluetooth, 3G or Camera), screen brightness, TouchPad power and Silent Mode.

You can click a **Control Center** icon to set an overall power mode and then click individual icons in the **Control Center** to power on/off any modules etc.

The **table overleaf** illustrates the basic settings for each power mode. If you choose user defined the settings will correspond to your selected system settings.
### Table B - 1 - Power Modes

<table>
<thead>
<tr>
<th>Modes</th>
<th>Power Saving</th>
<th>Flight</th>
<th>Entertainment</th>
<th>Quiet</th>
<th>Performance</th>
<th>User Defined</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Plan</td>
<td>Power Saver</td>
<td>Balanced</td>
<td>Power Saving</td>
<td>Power Saving</td>
<td>High Performance</td>
<td>User Defined</td>
</tr>
<tr>
<td>Brightness</td>
<td><img src="image" alt="Brightness Icon" /></td>
<td>14</td>
<td>42</td>
<td>100</td>
<td>42</td>
<td>100</td>
</tr>
<tr>
<td>WLAN</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>Bluetooth</td>
<td><img src="image" alt="Bluetooth Icon" /></td>
<td>BIOS Default</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC Camera</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>TouchPad</td>
<td><img src="image" alt="TouchPad Icon" /></td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
</tr>
</tbody>
</table>

*Table B - 1: Power Modes*
Control Center

Power Status

The **Power Status** icon will show whether you are currently powered by the battery, or by the AC/DC adapter plugged in to a working power outlet. The power status bar will show the current battery charge state.

Brightness

The **Brightness** icon will show the current screen brightness level. You can use the slider to adjust the screen brightness or the **Fn + F8/F9** key combinations, or use the **Fn+ F2** key combination to turn off the LED backlight (press any key to turn it on again). Note that screen brightness is also affected by the **Power Mode** selected (see *Table B - 1, on page B - 3*).

Volume

The **Volume** icon will show the current volume level. You can use the slider to adjust the Volume or the **Fn + F5/F6** key combinations, or use the **Fn+ F3** key combination to mute the volume.

Power Conservation

This system supports **Energy Star** power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity (see “**Power Conservation Modes**” on page 3 - 10). Click either the **Performance, Balanced** or **Energy Star** button. Click in a blank area of the icon or press a key on the keyboard to exit **Power Conservation Mode** without making any changes.
Sleep
Click the Sleep button to bring up the Hibernate or Sleep buttons, and click either button to have the computer enter the appropriate power-saving mode (see “Power-Saving States” on page 3 - 6). Click in a blank area of the icon or press a key on the keyboard to exit Power Conservation Mode without making any changes.

Display Switch
Click the Display Switch button to access the menu (or use the + P key combination) and select the appropriate attached display mode (see page C - 12).

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background
Clicking the Desktop Background button will allow you to change the desktop background picture.

TouchPad/PC Camera/Wireless LAN Module /Bluetooth Module
Click any of these buttons to toggle the TouchPad or module’s power status. A crossed out icon will appear over the top left of the icon when it is off. Note that the power status of a module, and TouchPad power, is also effected by the Power Mode selected (see Table B - 1, on page B - 3).
**Silent Mode (For Some Model A Designs Only)**

Click the **Silent Mode** button toggles silent mode on/off. You can use **Silent Mode** to reduce power consumption and fan noise. Note that the **Silent Mode** is affected by the **Power Mode** selected.

- Silent Mode is **OFF**
- Silent Mode is **On**

Note **Silent Mode** may reduce computer performance.

**Caps Lock/Scroll Lock/ Number Lock**

Click the button to toggle the appropriate lock mode.
Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 16.

Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).
2. Click Install VGA Driver > Yes.
3. Click Next > Yes > Next > Next.
4. Click Finish to restart the computer.

NVIDIA Video (VGA)

1. Click Install nVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next > Next.
4. Click the RESTART NOW button to restart the computer.

Note: After installing the video driver go to the Display/Display Settings control panel to adjust the video settings to the highest resolution.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to 1748MB) system memory (RAM) as needed to the integrated video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.

DVMT is not local video memory.
DVMT will not function in MS-DOS. DOS uses the legacy memory indicated.
NVIDIA® Optimus™ Technology

Most notebook computers come with either a discrete or integrated graphics solution.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU) which are capable of playing games, watching HD video or running GPU-based applications. However computers with discrete graphics solutions tend to be heavy in power consumption, and slightly larger in size in order to incorporate the dedicated discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help save power consumption and allow for longer battery life. However computers with integrated graphics solutions will not usually run games, HD video or GPU-based applications without severe limitations.

Nvidia® Optimus™ technology is a seamless technology designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. Thus when an application is run that requires extra performance or quality, then the system will run the discrete GPU (dGPU); when the system does not require such enhanced performance it will let the integrated (iGPU) handle it.
**How Optimus Technology works**

When the system is powered up and is displaying just the desktop, the dGPU will be powered off. In this case the system is running in the same way as a system without a discrete graphics solution. However when an application that requires use of the dGPU is run (e.g., a game or HD Video), the dGPU is powered on and takes over the processing duties. If the program is closed, then the dGPU will be powered back down again until required.

**Customization Options**

Although Optimus is completely seamless to the user, NVIDIA also allow customization options within the control panel (see "Optimus™ Customization Options" on page C - 15).
Video Driver Controls

Intel® Graphics & Media Control Panel

Advanced video configuration options are provided by the Intel® Graphics and Media Control Panel. To access the control panel:

1. Click **Advanced settings** in the **Screen Resolution** control panel in **Windows**.
2. Click the **Intel(R)...** tab and click **Graphics Properties** (button).
3. Right-click the desktop and select **Graphics Properties** from the menu.
4. Double-click the **Intel(R) G&M** control panel in **Windows**.
5. Choose the application mode (**Basic, Advanced or Wizard**) required (see sidebar).

**Figure C - 1**

Intel® G&M Control Panel
You may make changes to any of the graphics properties by clicking the appropriate menu tab on the left of the menu and adjusting the settings on the right.

**Options & Support**
Click **Options & Support** and select an item from the sub-menu to bring up the help and support topics.

You will need to be connected to the Internet to access the key resource links.

**Multiple Display**
At least one other display must be attached in order to view multiple display selection options.

*Figure C - 2*
Intel® G&M Control Panel Tabs
Display Devices & Options

Besides the built-in LCD you can also use an external monitor/flat panel display/TV connected to the external monitor port or to the HDMI-Out port (High-Definition Multimedia Interface) as your display device. The table below outlines the display options.

<table>
<thead>
<tr>
<th>Intel Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Display</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Clone Displays</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended Desktop</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

Function Key Combination

You can use the `Fn + F7` key combination to toggle through the display options:
- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

Note that HDMI supports video and audio signals.

Table C - 1

Display Modes

Attaching Displays

When you first attach an external display you may find that the desktop does not occupy the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R) G&M control panel to configure the full screen display.
Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the external monitor port or HDMI-Out port on the left of the computer.

To Clone Displays:
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Clone Displays from the menu.
4. Click Apply, and OK to confirm the settings change.
5. You can switch the Primary/Secondary Display from the menu.

Multiple Display
At least one other display must be attached in order to view Multiple Display selection options.

General Settings
Click General Settings to access settings the options for any attached display.

Figure C - 3
Display > Multiple Displays (Clone)
To Enable Extended Desktop:
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Extended Desktop from the menu.
4. Click Apply, and OK to confirm the settings change.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).

Click General Settings to make any adjustments required.
Display Profiles
You can save display settings to be loaded at any time.

1. Go to the Intel(R) G&M control panel and click Display.
2. Configure the General Settings, Multiple Displays, Color Enhancement, Custom Resolution & Monitor/TV Settings to your preferences.
3. Click Apply, and OK to confirm the settings change.
4. Click the Save button at the top of the General Settings, Multiple Displays or Color Enhancement menus (under Display Profiles).
5. Type a name for the Profile and click OK.
6. The Profile will be listed under Display Profiles.
7. Select the profile from the pull-down menu and click Apply, and OK to confirm the settings change.

![Intel® G&M Profiles](image)
Configuring an External Display in Windows 7

You can also use the Screen Resolution control panel in Windows 7 to configure an external display.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel (see “Video Features” on page -16).
3. Click the Detect button.
4. The computer will then detect any attached displays.

**Function Key Combination**

You can use the Fn + F7 key combination to toggle through the display options:
- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

Note that HDMI supports video and audio signals.

**Figure C - 6**

Screen Resolution Multiple Displays (Win 7)
5. You can configure the displays from the Multiple Displays menu.

- Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
- Extend these displays - Treats both connected displays as separate devices
- Show desktop only on 1/2 - Only one of your displays is used.
Using the Windows Logo Key + P Key Combination to Switch Displays
You can also use the Windows Logo Key + P key combination to quickly change display configuration and modes (this is particularly useful when attaching a projector) in Windows 7.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Press the Windows Logo Key + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or Windows Logo Key + P) to select the appropriate configuration from the menu, and press Enter to confirm the selection.

Figure C - 8
Windows Logo Key + P Display Configuration Selection (Win 7)
NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the menu if you are in Control Panel Home).

Figure C - 9
NVIDIA GeForce......
Control Panel
The NVIDIA Control Panel provides additional video configuration controls and tools which allow quick access to features such as image settings, 3D Settings and video configuration.

**Navigating the Control Panel**

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

Figure C - 10

NVIDIA Control Panel
Optimus™ Customization Options

One of the most important aspects of Nvidia® Optimus™ technology is that it will switch between the integrated GPU and discrete GPU seamlessly and automatically, and does not require any input from the user. However, customization options are offered for users who prefer to set their own parameters for GPU usage.

Context Menu

One of the quickest ways to choose which GPU to use for a particular application is by using the “Run with graphics processor” in the context menu.

1. Go to the NVIDIA Control Panel (see page C - 13).
2. Click Desktop from the top menu and select Add “Run with graphics processor” to Context Menu (it should have a tick alongside it).

![NVIDIA Control Panel - View](Image)
3. Close the NVIDIA Control Panel.
4. Find the executable file icon of the application you want to run.
5. Right-click the icon and select **Run with graphics processor** from the context menu.
6. Select either **High-performance NVIDIA processor** (dGPU) or **Integrated graphics** (iGPU) to run the program with the selected GPU.

---

**iGPU or dGPU**

Note the NVIDIA control panel refers to **High-performance NVIDIA processor** (which is the discrete GPU) and **Integrated graphics** (which is the integrated GPU).

---

**Figure C - 12**

Context Menu with **Run with graphics processor**

Right-click the application executable file.
Global Settings

Global settings allows you to set the preferred graphics processor for overall use. Ideally this would be the iGPU for battery life, but this can be set to the dGPU if preferred.

1. Run the NVIDIA Control Panel (see page C - 13).
2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
3. Select either Integrated graphics (iGPU) or High performance NVIDIA Processor (dGPU) from the drop-down menu.
4. Click the Setting menu items to select any options required.
5. Click Apply to save the settings.
Program Settings
Program settings allows you to make specific adjustments for installed applications.

1. Run the **NVIDIA Control Panel** (see page C - 13).
2. Click **Manage 3D Settings (3D Settings)** and select **Program Settings** (tab).
3. **Select a program to customize** from the drop-down menu, or click **Add** to add any program that does not appear in the menu.
4. **Select the preferred graphics processor for the program** from the drop-down menu.
5. Click the **Setting** menu items to select any options required.
6. Click **Apply** to save the settings.

*Figure C - 14*
Program Settings
Set PhysX® Configuration

NVIDIA® PhysX® is a physics engine that can use the GPU to accelerate game and 3D application performance. You can select the GeForce video card or CPU as a PhysX® processor, or configure the computer to auto-select a PhysX® processor (recommended default setting).

1. Go to NVIDIA Control Panel (see page C - 13).
2. Click Set PhysX configuration.
3. Click to Select a PhysX processor from the menu; Auto-select (recommended) is the default setting.
4. Click Apply to save the settings.
Video Settings

Click the sub-menus under Video to adjust the video color or image settings.

Figure C - 16
Video Settings
HDMI Audio Configuration

HDMI (High-Definition Multimedia Interface) carries both audio and video signals. In some cases it will be necessary to go to the Sound control panel and manually configure the HDMI audio output as per the instructions below.

1. Connect a device with HDMI support to the HDMI-Out port.
2. Click Start, and click Control Panel (or point to Settings and click Control Panel).
3. Click Sound (Hardware and Sound) and click Playback (tab).
4. Depending on your display, the playback device may be selected, however in some cases you may need to select the audio device and click Set Default (button).
5. Double-click the device to access the control panel tabs illustrated overleaf.

Figure C - 17
Sound - HDMI Device (set Default)
6. Double-click the connected HDMI device (or right-click and select Properties) to adjust the HDMI settings from the control panel tabs.
7. Click OK to close the control panel (see notes overleaf).

Figure C - 18
HDMI Device Properties
HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.
• To play audio sources through your external display’s (TV or LCD) speakers you will need to go to the audio configuration control panel on the display and configure the audio input accordingly (see your display device manual).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Attaching Other Displays” on page C - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

THX TruStudio Pro & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the THX TruStudio Pro controls will be disabled.
2. A warning box will pop-up and will prompt “Do you want to select another audio device now?”.
3. Click No to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display).

Other Applications
If you are using a third party application to play DVDs etc. from any attached DVD device, you will need to consult the application’s documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Video Driver Controls
Appendix D: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer’s release schedule. Check with your service center for details.
## Specifications

<table>
<thead>
<tr>
<th>Processor</th>
<th>Processor</th>
<th>Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel® Core i7-3612QM (2.1GHz) Quad-Core Mobile Processor 6M L3 Cache, 22nm (22 Nanometer), DDR3-1600MHz, TDP 35W</td>
<td>Intel® Core i7-2620M (2.7GHz) Mobile Processor 4M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Core i3-2370M (2.4GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
</tr>
<tr>
<td>Intel® Core i7-3520M (2.9GHz) Mobile Processor 4M L3 Cache, 22nm (22 Nanometer), DDR3-1600MHz, TDP 35W</td>
<td>Intel® Core i5-2540M (2.6GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Core i3-2350M (2.3GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
</tr>
<tr>
<td>Intel® Core i5-3360M (2.8GHz) Mobile Processor 3M L3 Cache, 22nm (22 Nanometer), DDR3-1600MHz, TDP 35W</td>
<td>Intel® Core i5-2520M (2.5GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Core i3-2330M (2.2GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
</tr>
<tr>
<td>Intel® Core i5-3320M (2.6GHz) Mobile Processor 3M L3 Cache, 22nm (22 Nanometer), DDR3-1600MHz, TDP 35W</td>
<td>Intel® Core i5-2450M (2.5GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Core i3-2310M (2.1GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
</tr>
<tr>
<td>Intel® Core i5-3210M (2.5GHz) Mobile Processor 3M L3 Cache, 22nm (22 Nanometer), DDR3-1600MHz, TDP 35W</td>
<td>Intel® Core i5-2430M (2.4GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Pentium® B970 (2.3GHz) 2M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
</tr>
<tr>
<td>Intel® Core i7-2640M (2.8GHz) Mobile Processor 4M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Core i5-2410M (2.3GHz) Mobile Processor 3M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Pentium® B960 (2.2GHz) 2M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
</tr>
<tr>
<td>Intel® Core i5-2620M (2.7GHz) Mobile Processor 4M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>Intel® Pentium® B950 (2.2GHz) 2M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W</td>
<td>See Over</td>
</tr>
</tbody>
</table>

---

**D - 2 Specifications**
### Specifications

#### Processor
- **Intel® Pentium® B950 (2.1GHz)**
  - 2M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W
- **Intel® Pentium® B940 (2.0GHz)**
  - 2M L3 Cache, 32nm (32 Nanometer), DDR3-1333MHz, TDP 35W

#### Core Logic
- Mobile Intel® HM76 Express Chipset

#### Display
- 11.6” / 29.46cm HD (1366 * 768), 16:9 Backlit Panel

#### Memory
- Dual Channel DDRIII (DDR3)
  - Two 204 Pin SO-DIMM sockets supporting DDR3 1333MHz / 1600MHz (real operational frequency depends on the FSB of the processor)
  - Memory Expandable up to **8GB** (using 1GB/2GB/4GB SO-DIMM Modules)

#### Video Adapter
- **Intel® Integrated GPU and NVIDIA® GeForce Video:**
  - Supports NVIDIA® Optimus
  - Switchable GPU Technology between iGPU and dGPU
- **Intel® HD Graphics 4000** / **Intel® HD Graphics 3000** or **Intel® HD Graphics Integrated GPU**
  - (GPU is Dependent on Processor):
    - Dynamic Frequency
    - Intel Dynamic Video Memory Technology up to 1.7GB
  - Intel® HD Graphics 4000 Supports Microsoft DirectX® 11.0
- **nVIDIA® GeForce GTX 650M** PCIe * 8 Video Card
  - 2GB gDDR3 Video RAM On Board
  - Supports Microsoft DirectX® 11.0
  - NVIDIA PhysX™
  - GeForce CUDA™ Technology
  - NVIDIA® Optimus 1.2 Technology

#### Storage
- One Changeable 2.5” / 9.5 mm (h) HDD with SATA (Serial) Interface

#### Keyboard & Pointing Device
- Built-in Touchpad with Multi-Gesture Functionality
- Isolated A4 Size Keyboard

#### Audio
- High Definition Audio Interface
- Built-In Microphone
- 2 * Built-In Speakers
- THX TruStudio Pro

#### Interface
- One powered USB2.0 port (AC/DC)
- Two USB 3.0 Ports
- One External Monitor Port
- One 1.4a HDMI-Out (High-Definition Multimedia Interface) Port (with HDCP)
- One Headphone-Out Jack
- One Microphone-In Jack
- One RJ-45 LAN Jack
- One DC-In Jack
### Specifications

<table>
<thead>
<tr>
<th>Card Reader</th>
<th>Communication</th>
<th>Indicators</th>
<th>Operating System</th>
<th>BIOS</th>
<th>Security</th>
<th>Environmental Spec</th>
</tr>
</thead>
</table>
| Embedded Multi-In-1 Push-Push Card Reader  
- MMC/ RS MMC  
- SD/ Mini SD / SDHC/ SDXC  
- MS/ MS Pro/ MS Duo  
**Note:** Some of these cards require PC adapters that are usually supplied with the cards. | **Combo WLAN** (802.11b/g/n) and **Bluetooth v4.0+LE** Half Mini-Card Module with PCIe Interface (**Factory Option**)  
802.11b/g/n Half Mini-Card WLAN Module (**Factory Option**)  
1.3M Pixel **PC Camera Module** with USB interface (**Factory Option**) | **LED Indicators** - Power/Suspend, Battery, HDD/ODD, Bluetooth/Wireless LAN, Num Lock, Caps Lock, Scroll Lock | **Windows® 7 with Service Pack 1** | **One 48Mb SPI Flash ROM**  
AMI BIOS | **Security**  
Security (Kensington® Type) Lock Slot  
BIOS Password | **Temperature**  
Operating: 5°C - 35°C  
Non-Operating: -20°C - 60°C  
**Relative Humidity**  
Operating: 20% - 80%  
Non-Operating: 10% - 90% |
| **Slot** | **Power Management** | **Power** | **Full Range AC/DC Adapter**  
AC input 100 - 240V, 50 - 60Hz,  
DC Output 19V, 4.74A (90 Watts)  
Removable 6 Cell Smart Lithium Ion Battery Pack 62.16WH | **Supports Wake on LAN**  
**Supports Wake on USB** | **Built-In 10/100/1000Mb Base-TX Ethernet LAN**  
**Intel® Centrino® Wireless-N 6235 2*2** (802.11 a/g/n) Half Mini-Card PCIe WLAN + Bluetooth Combo Module (**Factory Option**)  
**Intel® Centrino® Wireless-N 2230** (1*2 802.11 b/g/n) Half Mini-Card PCIe WLAN & Bluetooth Combo Module (**Factory Option**) | **Factory Option** |
### Specifications

**Features**

Painted Style (For some Model designs in this series)

Magic Of Film Art I Changeable LCD Back Covers (For some Model designs in this series)

**Dimensions & Weight**

287mm(w) * 207mm(d) * 12.7-37.1mm(h)

1.8 kg with 62.16WH Battery & ODD
Specifications